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Mengenali Toolbar icon yang umum 
digunakan

Berikut adalah toolbar standar pada OpenOffice beserta keterangan fungsi tombol-
tombol yang umum digunakan

icon keterangan

: New,  Untuk membuat dokumen baru. Untuk 
semua komponen OpenOffice

: Save, untuk menyimpan dokumen

: Open, membuka document

: Export ke PDF

: Spelling check on (aktif)

: Spelling check off (non aktif)

: print file langsung (tanpa review)

: print preview

: find, mencari kata atau kalimat

: as E-Mail, dokumen yang dibuat diperlakukan 
seperti email
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icon keterangan

menampilkan gallery

: zoom, level perbesaran halam

: tombol dan list style yang tersedia

: Tombol character style

: paragraf style

: bullet and numbering

: Undo dan redo

: Table

: Tombol navigator

: character check

: Next menu/button

: show draw function

tombol-tombol lainnya hampir serupa dengan button pada msOffice

Mengenali shortcut key pada OpenOffice

Standar shortcut key pada openoffice sama dengan msOffice, yaitu;

Cut (Control+X) 

Copy (Control+C) 

Paste (Control+V) 

Undo (Control+Z) 
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Redo (Control+Y) 

Save (Control+S) 

Open (Control+O) 

New (Control+N) 

Perbandingan fungsi 
shortcut lainnya

shortcut pada 
word

shortcut pada 
writer

msoffice OpenOffice

memberi  garis  bawah 
semua kata, kecuali spasi

Control + Shift + W tidak ada

Thesaurus  Shift + F7 Control + F7 

menampilkan/tidak 
character check

Control + Shift + * Control + F10 

Menggantung indent Control + T tidak ada

tidak menggantung indent Control + Shift + T tidak ada

 memberikan Indent   Control + M  tidak ada

menghilangkan Indent Control + Shift + M tidak ada

 Superscript Control + Shift =  Control + Shift + P 

Subscript    Control + =   Control + Shift + B 

menghilangkan formatting Control + Space bar klik kanan > Default 

menghilangkan  style 
paragraf

Control + Q klik kanan > Default 

kembali  ke  point  edit 
sebelumnya

Shift + F5      pada  navigator, 
reminder  diaktifkan 
(on)

Shift paragraph up  tidak ada   Control + Up 

Shift paragraph down tidak ada Control + Down 
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Perbandingan fungsi 
shortcut lainnya

shortcut pada 
word

shortcut pada 
writer

msoffice OpenOffice

cari kata Control + F Control + F 

mengganti kata Control + H Control + F 

Pemrosesan Document
untuk pemrosesan document, disarankan menggunakan style agar dokumen yang 
dihasilkan dapat teratur (untuk tutorial style dapat dibaca dibagian lain)

Menentukan format halaman

Sebelum membuat sebuah dokument, kita harus menentukan format kertas (page) 
yang akan digunakan seterusnya. Pada contoh dibawah ini, format halaman dibuat 
A4, dengan batas kiri, kanan, atas, dan bawah masing-masing 2 cm.

Menentukan format  kertas  pada OpenOffice  dengan mengklik  menu  format > 
page

Selanjutnya pilih bagian page dan berikan nilai-nilai sesuai dengan kebutuhan
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Format paragraf

Setelah selesai mempersiapkan format halaman, selanjutnya adalah menentukan 
format  paragraf  yang  diinginkan  pada  dokument  yang  kita  miliki.  Cara 
menentukan  format  paragraf  pun  tidak  jauh  berbeda  dengan  cara  menentukan 
format paragraf pada ms office.

Kali ini kita akan membuat format paragraf dengan jarak alinea pertama sejauh 
0.5cm, spasi  1.5 dan paragraf rata  kiri  kanan (justified).  Pilih  menu  format > 
paragraf. Lalu pada menu tab indent & spacing digunakan untuk mengatur jarak 
spasi yang diinginkan. 
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Selanjutnya untuk menentukan paragraf style (left,right, center atau justify) pilih 
menu  tab  alignment.  Untuk  pengaturan  paragraf  selanjutnya  anda  dapat 
bereksperimen dengan pilihan menu-menu yang tersedia

Memberikan bullet and numbering

Memberikan numbering ada pada  format > Bullet  and Numbering.  Beberapa 
pengaturan umum  bullet dan numbering juga dapat dilakukan disini.
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Pilih tab position untuk pengaturan posisi dan jarak bullet atau numbering sesuai 
dengan keinginan 
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Memberikan header dan footer

Pada  OpenOffice,  cara  memberikan  header  dan  footer  sedikit  berbeda  dengan 
yang ada pada msoffice.  Header atau footer sendiri  juga memiliki  fungsi yang 
sama dengan header atau footer pada msoffice, yaitu sebagai tempat page number, 
catatan kaki, page count, label, dan sebagainya.

Untuk mengaktifkan header atau footer, beri tanda cek (√) pada bagian tersebut 
melalui menu  insert > header > default (untuk header) atau  insert > footer > 
default (untuk footer).

Memberikan Fields pada Header atau footer (Page number 
atau page count)

Berbeda dengan penggunaan ms Word pada Windows, untuk memberikan fields 
seperti page number pada Oo Writer sebelumnya harus mengaktifkan header atau 
footer terlebih dahulu sebagai posisi field-field tersebut berada. 

field  yang  dapat  dimasukkan  adalah;  tanggal,  waktu,  penomoran  halaman, 
penghitung jumlah halaman,  subject,  judul,  dan nama penulis.  (lihat  pada 
gambar). Untuk memasukkan fields, sebelumnya jangan lupa untuk mengarahkan 
cursor  pada  header  atau  footer,  agar  fields  tersebut  dapat  tampail  pada  setiap 
halaman sesuai dengan yang diinginkan
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Mencetak document
Selesai  melakukan  pemrosesan  dokumen  sederhana,  saatnya  untuk  mencoba 
mencetak dokument di kertas. Pilih menu file > print atau gunakan [ctrl+p] untuk 
memulai mencetak halaman. Untuk preview dokumen, dapat menggunakan menu 
file > print preview atau menekan tombol print preview yang ada pada toolbar.

Untuk  pengaturan  kertas  dan  pencetakan  lainnya,  klik  properties  pada  jendela 
print
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Mail Merge Dengan openOffice

1.Membuat data source dan dokumen 
utama

• Membuat Address list/data source

Pada OpenOffice data source disebut juga sebagai address list. Address list dapat 
dibuat dari berbagai macam tipe file, baik database maupun spreadsheet. Biasanya 
pada database (dbf/odb) atau spreadsheet (ms.Excel atau OpenOffice Spreadsheet) 
yang telah kita miliki sebelumnya. Pada tutorial ini address list yang digunakan 
dibuat dari spreadsheet ms.excel (xls)

• Membuat dokumen utama

Pada OpenOffice  dokumen utama  disebut  sebagai  'starting  document'.  Sebagai 
contoh  dokumen  yang  dibuat  adalah  dokumen  surat  seperti  gambar  dibawah. 
Kemudian disimpan dengan nama file merge-coba.odt

2.Menggabungkan isi address list/data 
source ke dokumen utama

1) Memulai membuat mail merge dengan memilih menu tools -> mail merge 
wizard

2) Selanjutnya muncul beberapa pilihan untuk menentukan dokumen utama 
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yang akan dijadikan sebagai halaman utama dokumen. Pada contoh kali ini, 
dokumen yang digunakan adalah dokumen yang telah dibuat sebelumnya 
yaitu merge-coba.odt.  Pilih 'start  from existing document'  kemudian klik 
tombol  'browse'  untuk menentukan posisi  dokumen yang telah disimpan 
sebelumnya

3) Kemudian klik next

4) Selanjutnya  pada  menu  dokumen  type,  pilih  'letter'.  Artinya  kita  akan 
membuat dokumen surat yang dapat dicetak. Kemudian klik next

5) Pada menu jendela selanjutnya adalah tahap memasukkan alamat  (insert 
address block). Pada tahap ini terdiri dari 4 langkah; yaitu memilih data 
source,  menentukan  format  'address  block',  menyesuaikan  field  yang 
diinginkan  dengan  data,  memeriksa  dan  melihat  hasil  yang  diinginkan. 
Berikut langkah-langkahnya;

• Langkah pertama adalah dengan memilih data source  yang telah kita 
miliki sebelumnya dengan me-klik tombol 'select address list'. 
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• Kemudian muncul  jendela  pilihan address list  yang akan digunakan. 
Masukkan address list yang anda miliki dengan mengklik tombol 'add'

• Kemudian  pilih  dokumen  data  dengan  menyesuaikan  filetype  data 
source  yang anda  miliki.  OpenOffice  mendukung data  source  dalam 
berbagai  format,  salah  satunya  adalah  format  ms.excel  (xls)  dan 
ms.access(pdb) pilih kemudian klik open. Pada contoh file yang telah 
dibuat dari OpenOffice spreadsheet dengan nama file alamat-teman.odb

• Langkah  kedua  yaitu  menentukan  format  address  block.  Klik  more 
untuk menentukan format alamat yang akan tampil sesuai dengan yang 
anda  inginkan.  Ketika  anda  mengklik  tombol  more  akan  muncul 
tampilan seperti dibawah ini. Selanjutnya klik New 
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• Selanjutnya tentukan field-field yang ingin digunakan dan dicetak pada 
dokumen.  Sesuaikan  urutan  field  yang  ada  dengan  menekan  tombol 
atas,  bawah,  kiri,  atau  kanan yang ada  pada  jendela  dialog.  Apabila 
belum  menentukan  field  dengan  tabel  yang  dimiliki  pada  kolom 
preview akan muncul kalimat <not matched yet> artinya belum sesuai

• Langkah  ketiga  adalah  menentukan  field-field  pada  wizard  dengan 
kolom-kolom  pada  tabel  yang  kita  miliki.  Klik  match  field  untuk 
melakukan hal tersebut

• Selanjutnya akan muncul penyesuaian antara tabel dengan field-field 
yang tersedia. Kemudian klik ok

• Langkah keempat adalah melihat hasil yang telah dibuat sebelumnya. 
Apabila  dirasa  belum  sesuai  dapat  mengulangi  langkah-langkah 
sebelumnya, namun apabila dirasa sudah pas silahkan klik next
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6) Pada  menu  selanjutnya  adalah  menentukan  apakah  documen  yang 
diinginkan  juga  mengandung  kata-kata  pembuka/salution  seperti  yang 
terhormat, yang tercinta, yang tersayang ananda, dan lain sebagainya. Anda 
dapat menentukan apakah ingin menggunakan ucapan pembuka atau tidak. 
Apabila  anda  tidak  menginginkan  kalimat  pembuka,  cukup  hilangkan 
semua tanda checklist yang ada pada jendela dialog

7) Menu  selanjutnya  yaitu  menentukan  posisi  pada  kertas  yang  akan 
dicetak/layout.  Silahkan  menentukan  layout  sesuai  dengan  yang  anda 
inginkan.

8) Sebelum  mencetak  dokument  akan  ada  menu  pilihan  untuk  mengedit 
dokumen utama yang ada, namun apabila tidak ingin mengedit dokumen 
cukup klik next
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9) Menu ini  adalah untuk membuat halaman khusus didalam halaman mail 
merge.  Apabila  tidak  memiliki  halaman  khusus  yang  diinginkan, 
selanjutnya klik next

10)Langkah  terakhir  adalah  mencetak  document.  Dapat  mencetak  dalam 
bentuk file perhalaman atau langsung mencetak ke kertas.
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Mencetak Amplop

Pendahuluan

Mencetak  amplop  adalah  salah  satu  hal  wajib  yang  dilakukan  pada  kegiatan 
perkantoran. Mencetak amplop pada Openoffice sendiri agak rumit karena harus 
melakukan pengaturan sebelumnya pada konfigurasi printer. 

Tutorial ini dibuat menggunakan Linux. Cara yang sama dapat diimplementasikan 
pada Windows maupun Mac

Mengubah Setting Default Printer

Apabila  mencetak  amplop  dengan  menggunakan  setting  page  printer  A4  atau 
letter, hasil cetakan akan menjadi kacau. Sebelum mencetak amplop, ganti setting 
page printer terlebih dahulu.

File > Printer Settings > Properties

Ganti ukuran page dengan ukuran amplop
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3 Langkah Mencetak Amplop 
1. buat  dokument  untuk  amplop.  Pilih  menu  insert  >  envelope  atau  buat 

dokumen baru dan pilih format > page, pilih jenis amplop pada bagian page 
size. 

2. Ubah page size pada settingan printer (baca bagian sebelumnya)

3. Sebelum  mencetak,  konfigurasi  kan  juga  page  layout,  posisi  portrait  atau 
landscape. Lakukan beberapa ekperiment untuk penyesuaian.

Membuat dan Mencetak Document Amplop

1) Pilih file > New > Text Document

2) Pilih Format > Page

3) pilih tab Page

4) Pilih  kertas  jenis  amplop pada  list  Format,  berikan  opsi  landscape  dan 
page orientation serta margin yang diinginkan

5) klik OK

6) Buat  isi  amplop.  Sesuaikan  dengan  kebutuhan.  Anda  juga  dapat 
mengunakan  text  frame  untuk  mempermudah  pengaturan.  (Aktifkan 
Drawing function untuk menggunakan text frame)
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7) Setelah dokumen selesai dokumen siap dicetak

8) pilih file > print untuk memulai mencetak dokumen

9) Sebelumnya  pastikan  posisi  dan  settingan  layout  printer  sudah 
menyesuaikan untuk layout amplop

Cara Membuat Document Amplop Standard

Sebenarnya selain cara diatas, untuk membuat amplop, sebenarnya OpenOffice 
telah membuat standar pembuatan amplop sendiri. 

1)  Pilih insert > envelope

2) Tentukan alamat pengirim dan alamat tujuan

3) Pada bagian format, tentukan format ukuran amplop, margin, position dan 
lain sebagainya
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4) Pada  bagian  printer,  sesuaikan  setingan  posisi  kertas  pada  printer.  Agar 
hasil cetakan dapat tepat

5) Selesai. Klik Insert

6) Selanjutnya cetak amplop dengan file > print

7) Untuk amplop dengan database (mail merge) tidak dibahas disini.

8) pertanyaan kirim email ke mandah@ugm.ac.id
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Menggunakan Style Pada OpenOffice

Gambaran Umum
Style adalah salah satu fitur OpenOffice.org Writer yang paling handal. Mereka 
diperlukan untuk menggunakan kemampuan OOo Writer secara penuh. Bagian ini 
memperkenalkan style,  mengasumsikan pembaca belum mengenal  sebelumnya. 
Setelah  membaca,  Anda  akan  lebih  percaya  diri  menggunakan  style  paragraf, 
halaman, dan karakter.

Perkenalan

Apa itu style?
Sebagian besar pengguna terbiasa untuk menulis  dokumen berdasarkan attribut 
physical. Misalnya seseorang akan menentukan jenis font, ukuran, dan ketebalan 
(misalkan, Helvetica 12pt, bold).

Style  adalah  attribut  logical.   Kami  menggunakan  style  setiap  hari.  Sebagai 
contoh,  terdapat  dua  style  komputer:  desktop  dan  laptop.   Setiap  komputer 
memiliki propertinya masing-masing. Anda tidak pernah mengatakan “komputer 
saya  bersifat  sedang,  satu bagian dengan layar  LCD yang terhubung ke kotak 
berisi  komponen komputasi  dan  keyboard.  Tapi  Anda akan mengatakan “Saya 
memiliki sebuah laptop”.

Style OpenOffice.org adalah sebuah cara untuk melakukan hal yang sama pada 
dokumen Anda. Menggunakan style berarti  Anda berhenti mengatakan “ukuran 
font  14pt,  Times  New  Roman,  bold,  rata  tengah”,  dan  Anda  akan  mulai 
mengatakan “judul”.  Dengan kata lain, style berarti Anda mengubah empasis dari 
bagaimana teks tampak, menjadi teks itu sendiri.

Kenapa menggunakan style?
OpenOffice.org (OOo) menawarkan notasi style yang handal.  Style membantu 
meningkatkan  konsistensi  dalam  sebuah  dokumen.  Mereka  juga  membuat 
perubahan  major  pada  pemformatan  menjadi  mudah.  Misalnya,  Anda 
memutuskan untuk mengubah indentasi dari semua paragraf, atau merubah font 
dari  semua  judul.  Untuk  dokumen  yang  panjang,  hal  sederhana  ini  bisa 
merepotkan. Style membuatnya menjadi mudah.
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Waktu sekarang adalah 9:50 A.M. dan Jane sedang menyelesaikan paper 
dengan 30 halaman untuk sekolah yang akan digunakan pada 10:00 A.M. 
Dia melihat pada tugas sekali lagi, dan tiba-tiba dia menyadari bahwa:

• Teks harus menggunakan Arial dan bukan Times New Roman.

• Heading harus biru gelap dan mengandung indentasi.

• Judul  harus  muncul  pada  sisi  kanan  atas  pada  setiap  halaman, 
kecuali halaman pertama.

• Halaman genap harus memiliki margin kanan yang lebih lebar, dan 
halaman ganjil harus memiliki margin kiri yang lebih luas.

Untungnya,  Jane menggunakan OpenOffice.org dan style.  Dia membuat 
semua perubahan dalam 2 menit dan menyerahkan paper pada waktunya.

Jenis style
OpenOffice.org Writer memiliki lima jenis style:

• Style paragraf (Paragraf) berefek pada seluruh paragraf.

• Style  karakter  (Character)  berefek  pada  sekelompok  teks  dalam sebuah 
paragraf.

• Style halaman (Page) berefek pada pemformatan halaman (ukuran kertas, 
margin).

• Style frame (Frame) berefek pada frame dan grafis.

• Style penomoran (Numbering) berefek pada daftar bernomor dan bertanda 
bulat.

Tiga style pertama adalah yang paling sering digunakan. Style itulah yang akan 
dibahas  pada  bagian  ini.  Style  Frame  dan  penomoran  disisakan  pada  bagian 
selanjutnya.

Style  ini  tersedia  melalui  pallete  melayang  bernama  Stylist (tekan  F11 untuk 
melihatnya), tampak pada gambar 5.  Stylist akan dibahas pada bagian berikutnya.
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Gambar 1 Jendela Stylist; dan jenis style.

Catatan:  Stylist adalah palette melayang. Anda bisa menggesernya menggunakan 
mouse.
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Menggunakan style paragraf

Langkah pertama
OpenOffice.org menggunakan sebuah perkakas bernama Stylist untuk mengelola 
style.  Konsep style dan Stylist paling baik dijelaskan melalui contoh.

9) Buat sebuah dokumen baru (buka File > New > Text Document atau tekan 
Control+N).

10)Ketikkan “Heading 1” didalamnya.   Pastikan kursor berada dalam baris 
yang sama.

11)Tekan ikon Stylist  yang berada pada Function Bar atau tekan F11.  Ini 
akan menghadirkan sebuah jendela bernama Stylist (lihat Gambar 2).

12)Pastikan  Anda  berada  dalam  bagian  Paragraph  Styles (klik  pada  ikon 
paling kiri dalam Stylist ).

Gambar 2 Klik pada ikon Stylist untuk mengaktifkan Stylist.

Klik ganda pada daftar Heading 1 pada Stylist.  Hal ini akan melakukan dua hal:

• Memberikan style Heading 1 pada baris yang Anda tulis.

• Menambahkan Heading 1 pada menu Apply Style.

Menu Apply Style diilustrasikan pada Gambar 3. Ia menyediakan akses langsung 
pada style yang digunakan dalam dokumen.

Panduan OpenOffice 2.x Writer - halaman 28

 Cursor

 Stylist icon

 Paragraph Styles

 Stylist



Menggunakan menu Apply Style
Menu Apply  Style  mendaftar  style  paragraf  yang  digunakan  dalam dokumen. 
Anda  bisa  memilih  style  dari  menu  ini,  seperti  Stylist.  Sebagai  latihan,  tekan 
Enter, ketikkan beberapa teks dan pilih Heading 1 pada menu Apply Style.  Teks 
mendapatkan properti dari style Heading 1.

Gambar 3 Menerapkan style paragraf

Memodifikasi style paragraf
Kekuatan dari style terletak pada kemampuan untuk memodifikasinya agar sesuai 
kebutuhan  Anda.  Untuk contoh  berikutnya,  kita  kaan  membutuhkan tiga  baris 
dengan style Heading 1, Heading 2 dan Heading 3.  Dokumen Anda harus tampak 
seperti Gambar 4.  Style Heading 1 harus diterapkan pada kata “Title”,  Heading 2 
pada “Subtitle 1” dan seterusnya.
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Gambar 4 Headings 1-3 dengan style default.

Misalkan Anda memutuskan untuk membuat perubahan pada style ini:

• Heading 1 harus berada ditengah.

• Heading 3 harus diindentasi.

Heading 1 di tengah

Pada Stylist, klik kanan pada Heading 1 dan pilih Modify.

Gambar 5 Memodifikasi Style.

Ketika jendela Paragraph Style muncul, pilih tab  Alignment, pilih  Center dan 
klik OK.
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Gambar 6 Center Heading 1

Sekarang  semua  yang  bertanda  Heading  1  akan  terletak  di  tengah.  Jika  Anda 
membuat Heading 1 lain, ia juga akan berada di tengah.

Figure 7 Text is centered.

Indentasi Heading 3

Pada Stylist, klik kanan pada Heading 3 dan pilih  Modify (seperti sebelumnya). 
Ketika jendela Paragraph Style muncul, ikuti langkah berikut:

1) Klik pada tab Indents & Spacing.

2) Pada bagian Indent, tentukan indentasi “before the text” menjadi 1.5cm 
(0.6 in).
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Gambar 8 Menentukan indentasi

Hasilnya tampak pada Gambar 1.

Gambar 9 Teks dengan style Heading 3 diindentasi.

Style Terhubung
Beberapa  style  OpenOffice.org  terhubung  satu  sama  lain.   Hal  ini  berarti 
perubahan pada satu style berefek pada setiap style yang terhubung dengannya. 
Misalnya, setiap style  Heading (seperti Heading 1, Heading 2) terhubung dengan 
sebuah style bernama Heading.  Relasi ini diilustrasikan dalam gambar 6.

Gambar  10 Style  
terhubung.
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Sebagai contoh, misalkan Anda hendak mengubah font tidak hanya  Heading 1, 
atau  Heading  2,  tetapi  semua  heading.  Cara  termudah,  adalah  mengambil 
keuntungan dari linking.  Buka stylist (tekan F11) dan pilih Heading.

Gambar  11 Memilih  style  
Heading.

Buka jendela  paragraph style  untuk style  Heading (klik  kanan> Modify)  dan 
pilih tab Font.  Pilih font Corsiva dan klik OK (lihat Gambar 7).

Gambar 12 Pilih font Corsiva untuk style Heading.

Sekarang semua font dari semua style heading akan berubah dalam satu operasi. 
Dokumen Anda akan tampak seperti pada Gambar 8.
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Gambar 13 Semua style Heading memiliki font Corsiva.

Membuat style sendiri

Anda telah melihat Stylist menyediakan style terdefinisi, seperti Heading 1 dan 
Text  body.   Tetapi  bagaimana  jika  Anda membutuhkan sesuatu  yang  berbeda, 
seperti style puisi, yang tidak ada dalam Stylist?  Dengan OpenOffice.org Anda 
bisa membuat style untuk memenuhi kebutuhan Anda.

Pada bagian ini, kita akan membuat sebuah style Poem, dan style Poem Header, 
dengan properti berikut:

• Poem: Centered, dengan ukuran font 10.

• PoemHeading: Tengah, bold, dengan ukuran font 12.

Sebagai tambahan, Poem Heading diikuti dengan Poem.  Dengan kata lain, ketika 
Anda menekan Enter, style berubah menjadi Poem.

Catatan: Pembaca mungkin telah mengetahui perilaku ini sebelumnya. Setelah Anda 
menulis heading dan menekan Enter, style berpindah kembali ke Text body.

Membuat style Poem
Contoh pertama kita adalah style Poem.  Kita menggunakan style Default sebagai 
titik awal.

1) Klik pada ikon Stylist  untuk menampilkan Stylist (atau tekan F11).
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2) Klik kanan pada Default dan pilih New (lihat Gambar 9).

Gambar 14 Buat style baru.

Ini akan menampilkan jendela Paragraph Styles, dengan tab  Organizer terpilih. 
Untuk membuat style sendiri, Anda harus memahami dan mengkonfigurasi tiga 
entry teratas.

Name Ini adalah name style, seperti Heading 1 atau Text body.

Tentukan nama menjadi Poem.

Next Style Ini adalah style yang mengikuti style Poem secara default. 
Ketika Anda menekan Enter, style ini digunakan.

Tentukan nilainya menjadi Poem.  Ketika Anda menekan 
Enter, teks akan tetap pada style Poem.

Linked With Jika style Poem terhubung dengan yang lain, misalnya 
Default, maka perubahan pada Default akan berdampak pada 
Poem, seperti pada Heading pada bagian sebelumnya.

Untuk contoh kita, ini bukanlah perilaku yang kita inginkan. 
Tentukan entry ini ke  
– None – .  Hal ini berarti Poem tidak terhubung ke style 
lain.

Setelah membuat semua perubahan, layar Anda akan tampak seperti pada Gambar 
10.
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Gambar 15 Konfigurasi awal dari style Poem.  Tentukan nilai tiga entry pertama sebagai  
berikut.

Langkah selanjutnya adalah mengkonfigurasi perataan dan properti font dari style.

• Pada tab Alignment, pilih teks rata tengah.

• Pada tab Font, pilih ukuran font 10pt.

Klik OK untuk menyimpan style Poem baru.

Selamat! Anda telah membuat style Anda sendiri.

Menciptakan style PoemHeading
Membuat  style  PoemHeading baru.  Gunakan  prosedur  yang  sama  seperti 
sebelumnya, dengan perubahan berikut:

• Next style: Pilih Poem, bukan PoemHeading.

• Linked with: Heading.

Jendela seharusnya tampak seperti Gambar 11.
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Gambar 16 Setting untuk style PoemHeading.

Sekarang tentukan setting style baru:

• Pada tab Alignment, pilih teks rata tengah.

• Pada tab Font, pilih bold dan ukuran 12pt.
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Contoh puisi
Merupakan ide bagus untuk menguji  style  baru kita  dan melihat  apakah Anda 
puas. Puisi Anda akan tampak seperti pada Gambar 12.

Gambar 17 Contoh puisi.
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Merubah pemformatan style Anda
Salah  satu  keuntungan  dari  style  adalah  mereka  mengijinkan  pemformatan 
dokumen diubah setelah isinya ditulis. Misalnya, Anda telah menulis sebuah buku 
puisi dengan 100 halaman. Lalu Anda tidak suka dengan penampilan puisi. Atau 
misalnya penerbit Anda tidak menyukainya.

Untuk  mempelajari  tentang  mengkonfigurasi  ulang  style,  kita  akan  membuat 
perubahan berikut:

• Style Poem akan diindentasi dan bukan berada di tengah.

• Tambahkan sebuah style  PoemAuthor berdasarkan pada  Poem, kecuali ia 
tebal dan memiliki indentasi yang lebih.

Indentasi Poem dan Poem Header

Pertama, tentukan style Poem menjadi rata kiri:

1) Dari Stylist, pilih Poem, klik kanan dan pilih Modify.

2) Buka tab Alignment dan pilih rata kiri.

Tentukan indentasi:

1) Buka tab Indents & Spacing.

2) Pada Indent, tentukan indentasi “before the text” menjadi to 5cm (sekitar 
2in).

Selesai! Klik OK, dan Anda akan melihat perubahan teks. Lakukan hal yang sama 
untuk PoemHeading.

Membuat style Poem Author

Anda telah mengetahui cara membuat style baru. Ikuti prosedur yang sama seperti 
sebelumnya (mulai dari style Poem). Gunakan konfigurasi berikut:

• Name: PoemAuthor.

• Next style: Default.

• Linked with: Poem.

Sekarang, konfigurasi  PoemAuthor seperti Anda mengkonfigurasi  Poem, dengan 
perubahan berikut:

• Font: bold.

• Indentation: 8cm (3.2 in).

• Pada tab  Indents  & Spacing,  pada  Spacing,  tentukan spasi  “above the 
paragraph”  menjadi  0.5cm (0.2 in).   Hal  ini  menciptakan ruang kosong 
antara puisi dan penulis.
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Setting ditampilkan pada Gambar 13.

Tujuan dari style ini adalah memisahkan nama penulis dan isi puisi.

Gambar 18 Indentasi dan spasi untuk style PoemAuthor.

Ini adalah bagaimana tab  Indents & Spacing seharusnya pada bagian ini: Klik 
OK untuk  menyimpan style.  Sekarang tentukan penulis  puisi  (pada  kasus  ini, 
“Robert  Frost”) dengan style yang baru saja dibuat  Poem Author,  seperti  yang 
dijelaskan diatas.

Hasil akhir

Setelah semua perubahan ini, puisi akan tampak seperti Gambar 14.

Panduan OpenOffice 2.x Writer - halaman 40

 Edited entries 



Gambar 19 Hasil akhir, menggunakan tiga style berbeda

Tips dan trik
Anda bisa membuat Stylist  hanya menampilkan style custom. Klik pada menu 
dari jendela Stylist dan pilih “Custom Styles”.  Seperti tampak pada Gambar 15, 
Stylist hanya menampilkan Poem, PoemAuthor dan PoemHeading.
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Gambar 20 Menampilkan custom style.

Menggunakan style halaman dan 
penomoran halaman

Style halaman adalah untuk halaman dan style paragraf adalah untuk paragraf. 
Seperti pada style paragraf yang dapat mendefinisikan properti paragraf (ukuran 
font  dan warna),  style  halaman bisa  mendefinisikan properti  halaman (margin, 
ukuran kertas, dan sebagainya).

Situasi nyata

Christian adalah seorang pengacara dari California, USA. 
Dari suratnya, halaman pertama memiliki kepala surat, dan 
halaman berikutnya hanya mengidentifikasi penerima, 
tanggal, dan nomor halaman. Christian melakukannya 
menggunakan style halaman. Dia juga menggunakan style 
halaman untuk menyelesaikan kebutuhan spasi (seperti 
margin) untuk masalah legalitas dalam pengadilan daerah 
California.

Style halaman untuk halaman aktual ditampilkan pada status bar (Gambar 16).

Gambar 21 Style halaman aktual ditampilkan pada status bar.

Buka Stylist dan klik pada tombol Page Styles .
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Gambar 22 Memilih style halaman.

Klik kanan pada style halaman yang aktif (lihat Gambar  17) dan pilih  Modify. 
Hal ini menampilkan jendela, seperti tampak pada Gambar 18.

Gambar 23 Properti Halaman

Penomoran halaman
Banyak orang menemukan style  halaman ketika mereka perlu  memberi  nomor 
pada  halaman.  OpenOffice.org  (OOo)  memiliki  sistem  yang  handal  untuk 
penomoran  halaman,  tetapi  untuk  memaksimalkan  penggunannya,  Anda  harus 
mempelajari sesuatu tentang style halaman.

Bagian awal – field

OpenOffice.org menggunakan sebuah fitur bernama field  untuk mengelola nomor 
halaman. Untuk menyisipkan field nomor halaman, pilih Insert > Fields > Page 
Number.  Anda akan melihat nomor halaman pada latar belakang abu-abu. Latar 
belakang abu-abu menandakan sebuah field.

Catatan: Latar belakang abu-abu murni untuk tujuan informatif. Ketika Anda 
mencetak dokumen, latar belakang akan sama dengan dokumen. Buka View > Field 
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Shadings untuk menonaktifkan fitur ini.

Jika Anda telah melihat daftar pada OOo, Anda akan melihat latar belakang 
seperti ini. Daftar pada OOo menggunakan field.  Field nomor halaman selalu 
menampilkan nomor halaman dari halaman aktual. Jika Anda melihat kata “Page 
number” dan bukan angka, tekan Ctrl+F9. Tombol singkat ini mengubah OOo 
untuk menampilkan konten field (untuk apa sebuah field) dan hasil field (apa yang 
dibuat field).

Catatan: Pengenalan lengkap tentang field diluar jangkauan bagian ini.

Menyisipkan header

Pada OOo, header ditentukan oleh style halaman.

1) Buka dialog Page Style.

2) Pilih tab Header.

3) Pilih Header on dan klik OK (lihat Gambar 19).

Gambar 24 Mengaktifkan header halaman.

Saat ini Anda akan melihat header aktif pada halaman aktual, seperti pada Gambar 
20.

Gambar 25 Sebuah halaman dengan header halaman.

Apa yang spesial dari  header? Teks pada header muncul pada semua halaman 
dengan style halaman (cobalah!). Properti header (atau footer), bersama dengan 
field, membentuk basis untuk penomoran halaman pada OOo.

Tip: Anda juga bisa menambahkan header melalui menu Insert : Insert > 
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Header > [page style].
Begitu juga untuk footer: Insert > Footer > [page style].

Penomoran halaman sederhana

Contoh termudah adalah untuk memiliki  nomor halaman pada bagian atas dari 
setiap  halaman,  dan  tidak  lebih.Untuk  melakukannya,  tempatkan  kursor  ada 
header dan pilih Insert > Fields > Page Number (Gambar 21).

Gambar 26 Nomor halaman disisipkan pada header.

Presto! Sekarang nomor halaman yang benar tampak pada setiap halaman.

Variasi yang lebih kompleks

Terdapat  banyak variasi  menarik yang dapat Anda terapkan tanpa pengetahuan 
akan style halaman lebih lanjut. Berikut adalah beberapa saran:

• Buat header rata kanan sehingga nomor halaman muncul pada sisi kanan 
atas.

• Tambahkan  kata  “halaman”,  sehingga  header  bertuliskan  “halaman  1”, 
“halaman 2”, dan seterusnya.

• Tambahkan judul  dokumen,  sehingga header  bertuliskan “Buku Puisiku, 
halaman 12”.  Pertimbangkan menggunakan tab untuk memisahkan judul 
dari nomor halaman.

• OOo juga memiliki  field  Page Count (Insert  > Fields  > Page Count). 
Dengan  menggunakan  ini,  Anda  bisa,  misalnya  memiliki  header  yang 
bertuliskan “halaman 2 dari 12”.

Variasi ini diilustrasikan pada Gambar 22.
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Gambar 27 Variasi dari metode penomoran halaman sederhana.

Banyak  variasi  yang  mungkin.  Misalnya  Anda  bisa  menggunakan  footer  dan 
bukan header untuk membuat nomor halaman muncul pada bagian bawah dari 
dokumen.

Properti Next Style 
Anda telah melihat properti Next Style dalam konteks style paragraf. Properti ini 
sangat berguna dalam style halaman.

Membuat dua style halaman alternatif

Mungkin  penggunaan paling umum dari  properti  Next  Style adalah  berpindah 
antar  dua  style  halaman.  Misalnya,  jika  Anda  menulis  sebuah  buku,  Anda 
mungkin ingin setup berikut:

Halaman 
Ganjil

• Nomor  halaman  pada  sisi  kanan  atas  dari 
halaman.

• Nama penulis pada header.

• Margin kiri tambahan.

Halaman 
Genap

• Nomor halaman pada sisi kiri atas dari 
halaman.

• Judul buku pada header.

• Margin kanan tambahan.

Catatan: Margin ditentukan seperti ini untuk membuat proses lebih mudah setelah 
buku dicetak.

Hal ini bisa diselesaikan menggunakan apa yang sudah Anda ketahui tentang style 
halaman,  ditambah  penggunaan  properti  Next  Style yang  cerdik.   OOo 
menyediakan dua style halaman, yaitu Right Page dan Left Page. 

Pertama,  tentukan style  halaman  Right  Page untuk diikuti  oleh  Left  Page dan 
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sebaliknya.

1) Pada Stylist, buka jendela konfigurasi untuk style Right Page (Gambar 23).

Gambar 28 Klik kanan pada Right Page dan pilih Modify.

2) Klik pada tab Organizer, dan tentukan Next Style ke  Left Page (Gambar 
24).  Hal ini berarti setelah  Right Page, style halaman akan berpindah ke 
Left Page.

Gambar 29 Tentukan Next Style ke Left Page.

3) Dalam cara yang sama, tentukan Left Page diikuti dengan Right Page.

Tentukan halaman pertama dari dokumen menjadi Right Page.  Anda akan melihat 
bahwa style  halaman  Right  Page dan  Left  Page saling bergantian.   Anda bisa 
melihat  style  halaman  berubah  pada  status  bar  (Gambar  16)  ketika  Anda 
berpindah ke halaman selanjutnya. Sekarang kita bisa menentukan properti dari 
style Right Page dan Left Page.

Tentukan properti halaman untuk Right Page.

• Letakkan nomor  halaman  pada  sisi  kanan atas  dari  halaman,  dan  nama 
Anda pada header.

• Setting margin halaman terletak pada tab Page.  Tentukan margin kiri 4cm 
dan biarkan yang lain.  Lihat Gambar 25.
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Gambar 30 Tentukan margin halaman pada tab Page.

Dengan cara yang sama, tentukan properti halaman pada Left Page.

• Letakkan nomor halaman pada sisi kiri dari halaman, dan judul pada header 
(pilih sebuah judul untuk latihan ini).

• Tentukan margin kanan 4cm dan biarkan yang lain.

Gambar 26 mengillustrasikan transisi antara Right Page dan Left Page.

Gambar 31 Style Right Page dan Left Page bergantian.

Halaman judul

Pertimbangkan  skenario  yang  lebih  kompleks.  Anda  ingin  dokumen  memiliki 
halaman judul. Sebuah halaman judul berbeda dari sisa dokumen:

• Ia tidak mengandung header atau nomor halaman.

• Margin kiri dan kanan harus sama.

Untuk halaman judul kita bisa menggunakan style Front Page yang hadir dengan 
OOo.  Menentukan  header  dan  margin  ditinggalkan  sebagai  latihan  untuk 
pembaca. Bagian yang susah adalah bagaimana menghubungkan halaman depan 
dengan style halaman yang berganti (Right Page dan Left Page).  Triknya adalah 
untuk menentukan properti Next Page menjadi Right Page.  Dengan kata lain:

First  
Page

Next Style: Right  
Page

Right  
Page

Next Style: Left  
Page
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Left  
Page

Next Style: Right  
Page

Hasilnya diilustrasikan oleh bagan alir berikut (Gambar 27).

Gambar 32 Aliran style halaman.

Page break manual
Bagian sebelumnya membahas properti  Next Style.  Fitur ini mencukupi untuk 
proyek dengan kebutuhan penomoran (misalnya laporan, kepala laporan, dan buku 
yang  kcil).  Tetapi  proyek  yang  lebih  kompleks  membutuhkan  kontrol  lebih 
terhadap style halaman. Page break manual menyediakan kontrol ini.

Idenya  sederhana:  Anda  melakukan  break  terhadap  urutan  style  halaman,  dan 
memulai  urutan  baru.  Untuk menyisipkan page  break,  buka  Insert  >  Manual 
Break dan pilih  page break.  Bagian ini mengilustrasikan tiga skenario dimana 
page break berguna..

Contoh: Bab

Anda menulis sebuah buku yang dibagi menjadi beberapa bab. Setiap bab dimulai 
dengan  sebuah  style  halaman  bernama  New  Chapter.   Halaman  berikutnya 
menggunakan style Right Page dan Left Page.  Pada bagian akhir dari sebuah bab, 
kita kembali pada New Chapter, untuk bab berikutnya.

OOo tidak memiliki style New Chapter, sehingga Anda harus membuatnya (lihat 
halaman  34).   Mari  kita  anggap  Anda  telah  memiliki  style  halaman  dengan 
properti berikut:

New 
Chapter

Next Style: Right  
Page

Right  
Page

Next Style: Left  
Page

Left  
Page

Next Style: Right  
Page

Hal ini bisa divisualisasikan dengan bagan alir seperti Gambar 28.
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Gambar 33 Aliran style halaman.

Pada beberapa titik, Anda ingin memulai bab baru. Ikuti langkah berikut:

1) Letakkan kursor pada akhir bab, pada sebuah baris kosong.

2) Buka Insert > Manual Break.

3) Pilih Page break, dan pada style, pilih New Chapter.

Gambar 34 Pilih page break, dan pilih style halaman New Chapter.

Gambar 29 mengillustrasikan aliran dari style halaman ketika menggunakan page 
break.

Gambar 35 Aliran style halaman menggunakan page break

Contoh: Menyisipkan halaman dengan pemformatan khusus

Seringkali  Anda  mungkin  perlu  menyisipkan  sebuah  halaman  dengan  format 

Panduan OpenOffice 2.x Writer - halaman 50

New
Chapter

Right
Page

Left
Page

 Select style 

 Choose page break 

Chp
1

Right
Page

Left
Page

Chp
2

Right
Page

Left
Page

P
ag

e 
br

ea
k



khusus. Misalnya, sebuah halaman landscape, atau halaman dengan lebih banyak 
kolom. Hal ini juga bisa dilakukan dengan page break.  Misalkan halaman aktual 
memiliki style Right Page.

1) Insert > Manual Break.

2) Pilih  style  halaman  (misalkan,  Special  Page).   Halaman  ini  mengambil 
tempat yang seharusnya digunakan oleh Left Page.

3) Isi konten dari halaman. Lalu sisipkan page break lain.

4) Lalu  pilih  Right  Page kembali.   Penomoran  halaman  akan  dilanjutkan 
seperti biasa, kecuali Left Page telah digantikan oleh style halaman lain.

Konsep ini diilustrasikan pada Gambar 30.

Gambar 36 Menyisipkan sebuah halaman dengan format khusus.

Contoh: Mengulang penomoran halaman – pengantar

Seringkali Anda ingin mengulang penomoran halaman menjadi 1. Contoh umum 
adalah pengantar untuk sebuah buku. Pengantar standar memiliki properti berikut:

• Nomor halaman ditampilkan dalam Romawi (i ii iii iv ...).

• Setelah pengantar, dokumen dimulai pada Right Page.

• Nomor halaman dimulai dari 1, dan format menjadi Arab (1 2 3 4 ...).

Mengulang penomoran halaman membutuhkan page break.

Misalkan  pengantar  menggunakan  style  Preface  Page (yang  merupakan  style 
custom).  Setelah pengantar, hadir style Right Page, dan dua style halaman akan 
bergantian, Right Page dan Left Page.

Pertama-tama, mari kita lakukan untuk style Preface Page:

1) Buat style halaman baru bernama Preface Page.

2) Tentukan  Next  Style ke  Preface  Page,  karena  pengantar  bisa  dalam 
beberapa halaman.

3) Tambahkan sebuah header  pada  Preface  Page dan  sisipkan field  nomor 
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halaman.

Berikutnya buat nomor halaman ditampilkan dalam Romawi (i ii iii iv):

1) Buka dialog page style untuk Preface Page dan klik pada tabPage.

2) Pada Layout settings, tentukan format ke “i, ii, iii ...”.  Lihat Gambar 31.

Gambar 37 Tentukan format nomor halaman ke Romawi.

Setelah pengantar ditulis, kita siap mengulang penomoran halaman. Ikuti langkah 
berikut:

1) Letakkan kursor pada akhir dari pengantar, pada baris kosong.

2) Insert > Manual Break.  Pilih Page break dan pilih style Right Page.

3) Berikan tanda pada Change page number dan tentukan nilai 1.

Setting ditampilkan pada Gambar 32.

Gambar 38 Tentukan nilai nomor halaman ke 1 dan style halaman ke Right  
Page.

Catatan Penting: OpenOffice.org tidak akan mengijinkan Anda memberi nomor 
halaman ganjil pada Left Page, atau nomor halaman genap pada Right Page. OOo 
mengikuti aturan bahwa nomor halaman genap pada halaman kanan dan nomor 
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halaman genap pada halaman kiri.

Menggunakan style karakter

Style karakter adalah pelengkap terhadap style paragraf.  Seperti  style paragraf, 
mereka  mendefinisikan  properti  teks  (font,  ketebalan,  ukuran),  tetapi  mereka 
diterapkan pada blok yang lebih kecil daripada sebuah paragraf. Misalnya, Anda 
bisa menggunakan  style karakter Emphasis untuk membuat kata menjadi miring. 
Beberapa pasang style karakter yang digunakan pada dokumen ini meliputi:

• Penekanan  tombol  menggunakan  style  KeyStroke .  Misalnya,  “untuk 
membuat OOo dijalankan secara penuh, tekan Control+Shift+J”.

• Path  menu  menggunakan  style  MenuPath.  Misalnya,  “Anda  bisa 
mengaktifkan/menonaktifkan  field  shading  melalui  View  >  Field 
Shadings”.

Kenapa menggunakan style karakter?
Pengguna  awal  seringkali  bingung,“kenapa  menggunakan  style  karakter?”, 
“Bagaimana  ini  bisa  berbeda  dengan  menekan  tombol  bold?”.  Contoh  nyata 
berikut mengillustrasikan perbedaan tersebut.

Situasi nyata

Jean adalah penulis teknis dari Australia.  Dia mempelajari nilai 
style karakter setelah penerbitnya memberitahu untuk 
menghapus setting bold dari path menu untuk bukunya yang 
berjumlah 200 halaman. Jean tidak menggunakan style karakter. 
Dia harus mengedit seluruhnya secara manual dengan bantuan 
dari Find and Replace.

Ini adalah terakhir kalinya Jean gagal menggunakan style 
karakter.

Style karakter  tidak memiliki  opsi  sebanyak style  paragraf atau style  halaman. 
Keuntungannya berbeda secara alami:

• Perubahan  pemformatan.
Seperti  pada  contoh  illustrasi  Jean,  kemampuan  untuk  melakukan 
perubahan  pada  dokumen  dapat  menjadi  penting.  Style  karakter 
menyediakan hal ini.
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• Konsistensi.
Style karakter membantu memastikan petunjuk penulisan diterapkan secara 
konsisten.

• Fokus  pada  konten.
“Apakah saya harus menebalkan penekanan tombol? Bagaimana dengan 
menu?”
Seorang  penulis  tidak  seharusnya  mengingat  jawaban  dari  pertanyaan 
seperti  ini.  Detail  penulisan  menganggu  Anda  dari  konten  asli  dari 
pekerjaan Anda. Sebuah style karakter (seperti  KeyStroke atau  MenuPath) 
akan menghapus batasan ini untuk Anda.

Cara lain menggunakan style karakter dijelaskan pada bagian lain dari Petunjuk 
Writer. Petunjuk ini meliputi membuat nomor bab, nomor halaman, atau daftar 
angka  yang  lebih  besar  dari  teks  yang  mengelilinginya  dan  pemformatan 
hyperlink.

Menggunakan style karakter

Buka stylist  (tekan  F11)  dan klik tombol kedua pada bagian atas  .   Hal ini 
menampilkan  daftar  style  karakter  yang  tersedia.  Untuk  menerapkan  style 
karakter, ikuti langkah berikut:

1) Tandai teks dimana Anda ingin menerapkan style.

2) Klik ganda style karakter yang sesuai.

Beberapa contoh termasuk:

Contoh ini menggunakan style karakter Emphasis.

Definisi: Sebuah pernyataan menjelaskan arti sebuah kata atau frase.

Catatan: Satu perbedaan antara style karakter dan style paragraf dan style paragraf 
adalah kebutuhan untuk menandai. Style karakter mengharuskan Anda menandai 
teks; style paragraf tidak perlu.

Membatalkan/menghapus style karakter

Seringkali  Anda  ingin  menghapus  format  dari  sebuah  blok  teks.  Anda  harus  
menahan  diri  untuk  tidak  melakukannya  secara  manual.   Ini  hanya  akan 
mengakibatkan  masalah  pada  prosesnya.  Terdapat  dua  cara  untuk  menghapus 
pemformatan karakter:

• Pilih blok teks, klik kanan dan pilih Default.

• Jika Anda telah membuka Stylist, klik pada style karakter Default.

Catatan: Secara tidak sengaja, metode pertama juga bekerja untuk menghapus 
pemformatan manual
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Migrasi ke style karakter

Bagi  orang  yang  terbiasa  memformat  secara  manual,  style  karakter  dapat 
membutuhkan  waktu  untuk  terbiasa.  Berikut  adalah  beberapa  saran  untuk 
membuat proses transisi mudah:

• Jangan  menggabungkan  style  karakter  dan  pemformatan  manual. 
Pemformatan  manual  akan  menimpa  style  karakter.  Jika  Anda 
menggabungkannya,  Anda  akan  menghadapi  frustasi  untuk  mencari 
mengapa style karakter tidak bekerja.

• Klik  kanan  >  Default menghapus  sembarang  pemformatan  teks  (baik 
manual dan style karakter).

• Pahami bahwa meng-klik  pada tombol  bold  tidak lebih mudah  daripada 
meng-klik pada style karakter.

• Biarkan Stylist terbuka untuk mempermudah mengakses style karakter.
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